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How	to	sync	calendar	on	android	phone.	Mobileiron	calendar	not	syncing	iphone.	How	to	sync	my	outlook	calendar	to	my	android	phone.

One	of	the	things	I	love	about	Google	Calendar	is	that	it	requires	no	desktop	component.	Sure,	you	can	sync	it	with	Outlook,	but	not	everyone	needs	or	wants	a	program	like	that	just	to	manage	appointments.	Indeed,	more	and	more	people	prefer	to	keep	their	calendars	on	their	mobile	phones,	just	as	they	do	their	address	books.	If	you	do	use	Outlook,
you’ve	probably	already	configured	it	to	sync	with	your	phone.	If	not,	or	if,	like	me,	you’re	trying	to	migrate	away	from	that	unwieldy	beast,	look	no	further	than	Google	Sync–a	free	service	that	syncs	mobile	phones	with	Google	Calendar.	And	not	just	Google	Calendar,	but	also	Google	Contacts	and	Gmail.	The	service	works	with	BlackBerry,	iPhone,	and
Nokia	S60	devices.	(Why	not	Android?	Because	Google’s	mobile	OS	already	syncs	with	the	various	Google	services,	natch.	As	for	the	Palm	Pre	and	Pixi,	they	can	sync	with	Google	right	out	of	the	box.)Google	provides	all	the	instructions	you	need	for	configuring	and	using	Google	Sync,	so	I	won’t	rehash	them	here.	My	goal	is	simply	to	explain	why	it’s	a
good	idea.If	you’re	already	a	Google	Calendar	user,	it	should	be	pretty	obvious:	Sync	brings	a	copy	of	your	schedule	to	your	phone–and	keeps	both	versions	up	to	date.	Handy!If	you’re	not	a	Google	Calendar	user,	Sync	effectively	gives	you	an	online	backup	of	your	schedule–something	that	could	prove	invaluable	if	your	phone	gets	broken,	lost,	stolen,
etc.Plus,	there’s	much	to	be	said	for	having	a	calendar	that’s	accessible	from	any	Web-enabled	device	(desktop,	netbook,	iPad,	etc.).	Same	goes	for	your	contacts.	To	add	Yahoo,	go	to	Settings	>	Passwords	&	Accounts	>	Add	Account	>	Yahoo,	enter	Yahoo	address,	and	tap	Next	>	Password	>	Sign	in.To	set	sync	frequency,	go	to	Settings	>	Passwords
&	Accounts	>	Fetch	New	Data	>	Yahoo	>	Fetch	and	select	the	frequency.To	remove	an	account,	go	to	Settings	>	Passwords	&	Accounts	>	Yahoo	>	Delete	Account	>	Delete	from	My	iPhone.	This	article	explains	how	to	sync	a	Yahoo	Calendar	with	an	iPhone	calendar.	Instructions	apply	to	iPhones	with	iOS	12,	iOS	11,	or	iOS	10.	Yahoo	Calendar	is
available	on	the	iPhone	as	part	of	a	linked	Yahoo	Mail	account.	With	Yahoo	Calendar	activated,	events	appear	in	your	iPhone	calendar	automatically.	Setting	up	Yahoo	Calendar	and	the	iPhone	Calendar	to	synchronize	in	the	background	is	easy.	Any	changes	to	the	Calendar	updates	on	both	the	iPhone	and	your	Yahoo	account.	If	you	have	not	yet	added
the	Yahoo	as	an	email	account	to	iPhone	Mail:	Open	iPhone	Settings	and	tap	Passwords	&	Accounts.	Tap	Add	Account	in	the	Accounts	section.	Choose	Yahoo	from	the	list	of	preconfigured	providers.	Type	your	full	Yahoo	Mail	address	where	it	says	Enter	Your	Email	and	tap	Next.	Enter	your	Yahoo	Mail	password	under	Password	and	tap	Sign	in.	Move
the	slider	next	to	Calendars	to	the	On/green	position.	Also	move	the	sliders	for	Mail,	Reminders,	Contacts,	and	Notes.	Tap	Save.	If	you	added	Yahoo	to	your	Mail	account	previously,	you	might	not	have	turned	on	the	Calendar	feature.	To	check	this,	go	to	Settings	>	Passwords	&	Accounts	>	Yahoo	and	confirm	the	slider	next	to	Calendars	is	set	to
On/green.	If	not,	turn	it	on.	To	set	up	the	frequency	your	iPhone	checks	for	Yahoo	mail	and	calendar	additions:	Return	to	Settings	>	Passwords	&	Accounts.	Tap	Fetch	New	Data	at	the	bottom	of	the	screen.	Tap	the	Yahoo	account	entry.	Check	Fetch.	Select	Fetch	New	Data	at	the	top	of	the	screen	to	return	to	the	previous	screen.	Scroll	to	the	bottom
of	the	screen	and	tap	the	frequency	you	want	the	iPhone	to	sync	with	non-iCloud	Mail	accounts.	If	you	find	that	your	account	isn't	syncing	properly,	you	should	delete	and	then	re-add	your	Yahoo	account.	To	remove	a	synced	Yahoo	Calendar	account	from	your	iPhone:	Tap	Settings	on	the	iPhone	Home	screen.	Select	Passwords	&	Accounts.	Tap	your
Yahoo	account.	Tap	Delete	Account	and	confirm	the	deletion	by	tapping	Delete	from	My	iPhone	in	the	pop-up	window.	Thanks	for	letting	us	know!	Get	the	Latest	Tech	News	Delivered	Every	Day	Subscribe	Tell	us	why!	We	love	platform	convergence,	because	it	allows	us	to	sync	our	devices	in	newer	and	more	useful	ways.	Take	the	growing
compatibility	between	mobile	Android	devices	and	Windows	10.	Where	once	the	two	were	barely	on	speaking	terms,	you	can	now	make	Android	notifications	and	alerts	sync.	In	practical	terms,	this	means	that	you	can	keep	track	of	everything	happening	on	your	smartphone	while	you	work	on	Windows	10	—	without	glancing	down	at	your	phone
screen	every	time.	The	key	is	Cortana,	the	digital	assistant	on	Windows	10	and	Xbox	One;	her	capabilities	include	syncing	between	devices,	and	we’ll	run	you	through	exactly	how	to	do	so.	Step	1:	Download	Cortana	for	Android	While	there	are	third	party	apps	available	that	allow	some	Android-to-Windows	communication,	the	easiest	option	is	to	let
Cortana’s	official	app	do	that	work.	To	do	that,	you	need	Cortana	on	your	Android	phone,	so	head	over	to	the	Google	Play	store	on	your	phone	and	download	the	Cortana	app.	It’s	free,	and	compatible	with	most	modern	Android	mobile	devices.	However,	if	you	are	using	your	Android	phone	in	a	BYOD	scenario,	make	sure	that	your	company	is	okay	with
you	downloading	a	voice	assistant	and	linking	accounts	this	way.	Step	2:	Sign	in	Once	Cortana	is	installed,	you	should	transition	over	to	a	welcome	screen.	If	not,	try	restarting	the	Cortana	app	to	kick	it	into	motion.	You	will	see	a	friendly,	“Hi!”	from	Cortana,	and	then	she	will	ask	you	to	sign	into	your	Microsoft	Account.	You	will	need	your	own
Microsoft	Account	and	password	for	this	step.	If	you	aren’t	sure	if	you	have	a	Microsoft	account	or	not,	remember	that	it	will	be	the	same	sign-in	you	used	for	past	Windows/Xbox	services.	If	you	haven’t	started	using	Windows	10	yet	and	don’t	have	a	history	with	Microsoft,	creating	a	login	is	very	easy.	After	you	sign	in,	you	will	see	an	option	to	allow
Cortana	to	actively	listen	for	her	“Hey	Cortana”	activation	line	in	case	you	want	to	give	commands	to	your	Android	device.	This	depends	on	your	current	use	of	voice	assistants.	Most	Android	devices	have	an	“Ok	Google”	command	option	these	days,	and	if	you	are	already	used	to	that,	then	there	isn’t	much	of	a	reason	to	adopt	a	new	voice	assistant.
But	if	you	prefer	Cortana	to	Google’s	voice	assistant	—	and	there	are	reasons	to	do	so	—	then	check	away	and	move	onto	the	next	step.	Step	3:	Sync	basic	notifications	Cortana	will	now	begin	to	access	information	on	your	Android	device,	getting	up	to	speed	on	your	data.	Yes,	this	does	mean	that	Microsoft	will	have	access	to	your	Android	data.	You
can	read	more	about	what	Cortana	does	with	your	data	here,	and	what	sort	of	privacy	you	can	expect.	When	this	is	finished,	go	to	the	top	left	of	your	screen	and	select	the	three-lined	button	there.	Here,	look	for	an	option	that	says,	“Sync	notifications.”	Choose	it,	and	that	will	take	you	to	a	another	settings	menu	that	will	show	you	the	basic
notifications	you	can	enable.	Any	of	these	Android	notifications	that	are	enabled	will	also	show	up	on	Windows	10	in	your	little	Cortana	alert	box.	The	basic	phone	stuff	is	all	here	—	low	battery	warnings,	text	alerts,	missed	calls,	and	so	on,	so	pick	which	alerts	you	want	to	receive.	Step	4:	Choose	specific	syncing	for	app	alerts	If	you	continue	down	the
Sync	notifications	list,	you	will	notice	an	option	for	App	Notifications	Sync	(or	possibly	Choose	what	apps	to	sync,	depending	on	your	setup).	Choose	this	and	you	can	sync	the	notifications	for	any	compatible	Android	app	from	a	list.	Chances	are	good	that	you	have	a	lot	of	these	apps,	so	take	some	time	to	go	through	them	all	and	make	sure	only	the
important	apps	are	selected.	You	probably	don’t	want	any	random	browser	notifications	or	additional	calendar	alerts,	but	if	there	are	apps	you’d	like	Android	notifications	from,	swipe	right	to	activate	them	and	you	will	receive	those	alerts	too.	Step	5:	Hop	over	to	Windows	and	restart	Head	to	your	Windows	10	computer	and	restart	it:	It’s	not	always
necessary,	but	it’s	a	good	idea	to	ensure	smooth	syncing.	After	you	login	again,	make	sure	that	Cortana	is	showing	notifications	from	your	Android	phone.	After	that,	you	are	all	set!	Note	that	you	may	be	able	to	increase	compatibility	with	features	like	the	Microsoft	Phone	Companion.	Reminder:	If	it	isn’t	working,	check	your	Windows	10	Cortana
settings	to	make	sure	that	Cortana	can	access	information	from	other	devices.	Editors'	Recommendations	Click	to	viewAs	of	yesterday's	announcement	of	CalDAV	support	in	Google	Calendar,	you	can	now	sync	your	Google	Calendar	with	virtually	any	popular	desktop	calendar	for	free.	Not	only	can	you	enjoy	your	favorite	desktop	calendar	software
and	still	get	the	benefit	of	the	web	interface,	but	you	can	also	sync	any	desktop	calendar	with	any	other	across	platforms	using	GCal	as	a	go-between.	Let's	take	a	comprehensive	look	at	how	to	set	up	bidirectional	syncing	between	Google	Calendar	and	your	favorite	desktop	calendar—from	Outlook	and	iCal	to	Sunbird	and	Thunderbird—for	free.Google
Calendar	has	added	support	for	the	CalDAV	standard,	opening	up	a	realm	of	syncing…Read	moreRemember,	this	doesn't	mean	that	you	can	sync	Google	Calendar	with	just	one	desktop	calendar.	It	means	that	no	matter	what	you're	using—Outlook	at	work	and	iCal	at	home,	for	example—you	can	always	stick	to	desktop	calendars	if	that's	what	you
prefer.	Google	Calendar	now	works	as	both	a	great	web	application	and	a	dedicated	syncing	tool.	It's	the	cloud,	and	once	it's	set	up,	you	don't	ever	have	to	access	your	calendar	through	the	web	again	if	you	don't	feel	like	it.	But	when	you're	not	at	a	desktop,	you	can	fire	up	GCal	from	any	web	browser,	make	changes,	and	still	be	confident	your	desktop
is	completely	in	sync	next	time	you	fire	it	up.	Let's	get	started.Sync	Microsoft	Outlook	with	Google	Calendar	Syncing	calendar	events	between	Outlook	and	Google	Calendar	has	been	a	cinch	ever	since	Google	came	out	with	Google	Calendar	Sync,	a	free	application	that	provides	bidirectional	syncing	between	the	two.	(It	also	supports	one-way	sync	in
either	direction,	if	for	some	reason	you	don't	want	two-way	syncing.)	Assuming	you're	using	a	supported	setup	(Outlook	2003	or	2007	and	either	Vista	or	XP),	here's	how	to	get	it	working.Select	your	sync	method	(most	likely	you	want	two-way	syncing)	and	the	sync	frequency	you	prefer.	It	defaults	to	syncing	every	120	minutes,	which	seems	a	little
long	for	most.Hit	Save	and	you're	done.	Easy,	right?If	you've	added	a	new	item	to	your	calendar	and	you	want	to	force	a	new	sync	rather	than	waiting	for	Google	Calendar	Sync	to	run	its	next	sync,	just	right-click	the	system	tray	app	and	choose	Sync.	It	doesn't	get	much	simpler	than	that.Sync	iCal	with	Google	CalendarUPDATE:	Since	this	post	was
written,	Google	released	a	new	utility	called	Calaboration	that	handles	iCal-to-Gcal	sync	setup	with	even	more	ease.	(Original	post)Mac	OS	X	only:	Google	announced	CalDAV	support	in	Google	Calendar	this	summer,	which	meant	that…Read	moreAs	of	yesterday,	Google	Calendar	supports	two-way	synchronization	with	iCal	through	the	CalDAV	remote
calendar	standard.	Setting	up	iCal	with	GCal	varies	slightly	based	on	whether	or	not	you're	using	your	default	GCal	calendar	or	a	secondary	calendar.	First,	here's	how	to	set	up	your	Google	Calendar	default	with	iCal:Open	iCal,	then	fire	up	your	iCal	Preferences	(iCal	->	Preferences	or	Cmd-,).Click	on	the	Accounts	tab,	and	then	click	the	'+'	button	to
add	a	new	remote	calendar	to	iCal.Call	the	calendar	whatever	you	want	(I	went	with	'Personal'	for	my	main	calendar),	then	enter	the	Google	account	username	(which	is	normally	your	Gmail	address)	and	password.Click	on	Server	options	to	display	the	Account	URL	text	box.	For	your	default	calendar,	enter	the	following	URL:
gmail.com/user...replacing	youremail@gmail.com	with	your	actual	email	address.Once	you've	done	that,	just	hit	Add	and	you're	finished.	Give	iCal	a	few	minutes	to	download	all	your	events	and	you're	good	to	go.If	you	want	to	add	a	secondary	calendar,	the	steps	are	exactly	the	same	as	above	with	one	small	difference.	Instead	of	inserting	your	email
address	in	the	Account	URL	as	described	in	step	4,	you	need	to	grab	the	calendar	ID	for	that	specific	calendar.	You	can	find	it	by	opening	GCal,	clicking	the	arrow	next	to	the	calendar	you	want	to	sync,	and	selecting	Calendar	settings.	In	the	settings,	find	the	Calendar	Address	section	near	the	bottom	of	the	window,	then	just	copy	and	paste	the
Calendar	ID	(which	is	formatted	like	an	email	address)	in	place	of	youremail@gmail.com	in	the	URL	above.	You	can	refresh	iCal	to	make	sure	you've	synced	the	latest-and-greatest	at	any	time	by	selecting	Calendar	->	Refresh	or	hitting	Cmd-R.	(Original	post)Sync	Mozilla	Sunbird	or	Thunderbird	with	Google	CalendarWhether	you're	using	Mozilla's
standalone	calendar	application	Sunbird	or	Thunderbird	with	the	Lightning	extension	installed	(Lightning	integrates	Sunbird	into	Thunderbird),	bidirectional	calendar	syncing	between	either	application	and	Google	Calendar	is	a	breeze.	The	special	sauce	in	this	sync	is	the	Provider	for	Google	Calendar	extension.	Installing	Provider	in	either	Sunbird
or	Thunderbird	is	basically	the	same	procedure,	and	here's	how	it	works:Download	and	install	the	Provider	extension	by	saving	it	to	your	desktop,	opening	the	Add-ons	dialog	in	either	Sunbird	or	Thunderbird,	and	dragging	the	file	you	just	downloaded	into	the	Add-ons	dialog.	Once	installed,	make	sure	to	restart	the	application.Now	that	Provider	is
installed,	you	have	to	add	your	new	Google	Calendar.	In	Sunbird,	go	to	File	->	New	Calendar;	in	Thunderbird,	it's	File	->	New	->	Calendar	when	you're	in	the	calendar	view.You're	now	looking	at	the	Create	new	calendar	wizard.	Select	"On	the	Network"	and	hit	Continue.Choose	Google	Calendar	as	the	calendar	type.	The	Location	field	requires	the
XML	flavor	of	your	calendar's	Private	Address,	which	you	can	get	by	opening	GCal	and	choosing	Calendar	settings	from	the	drop-down	next	to	the	calendar	you	want	to	access.	At	the	bottom	of	the	settings	page	you'll	see	the	Private	Address	section.	Copy	the	XML	link	and	paste	it	into	the	Location	field	in	Sunbird	or	T-bird.When	you	hit	Continue,
you'll	be	asked	for	your	Google	Calendar	username	(again,	your	Gmail	address)	and	password.	Enter	it,	give	your	new	calendar	a	name,	and	hit	Continue.	You're	done.From	now	on,	any	event	you	add	to	that	calendar	will	automatically	sync	to	GCal	and	vice	versa.	You	can	reload	the	calendar	to	get	the	most	up-to-date	information	at	any	time	by
clicking	the	Reload	button	in	your	toolbar.	(The	button	is	installed	in	the	toolbar	by	default	in	Thunderbird,	but	you	may	have	to	customize	your	Sunbird	calendar	to	add	it	to	the	toolbar.)Sync	Your	Mobile	Device	with	Google	Calendar	If	you're	interested	in	syncing	your	mobile	device	with	Google	Calendar,	you've	also	got	a	ton	of	great	and	free
options.	BlackBerry	users	can	check	out	Google	Sync,	a	BlackBerry	app	made	by	Google	specifically	for	Gcal-to-BlackBerry	syncing.Alternatively,	the	free,	open-source	application	GCalSync	does	bidirectional	syncing	between	Gcal	and	tons	of	supported	phones.	(Original	post)Freeware	program	GcalSync	offers	two-way	synchronization	between	Gcal
and	your	mobile	device's…Read	moreIf	you're	an	iPhone	or	iPod	touch	user,	you	can	set	up	automatic,	two-way	syncing	between	your	Google	Calendar	(and	Gmail	contacts)	with	web	site	NuevaSync.	(Original	post)We've	shown	you	how	to	set	up	free	push	email,	contacts,	and	calendars	on	your	iPhone,	but	for…Read	moreFinally,	if	your	phone
supports	SyncML,	web	application	GooSync	can	handle	Gcal	syncing	without	installing	anything.Other	OptionsIf	you're	not	happy	with	the	methods	detailed	above—which	I	selected	because	each	represents	the	easiest	and	cheapest	(read:	free)	option—there	are	still	tons	of	other	tools	to	sync	Google	Calendar	with	your	desktop	calendar.	First,	we've
covered	how	to	sync	Google	Calendar	and	Gmail	contacts	with	the	more	technical	GCALDaemon.	Also,	the	cross-platform	Calgoo	just	went	free,	with	both	Outlook	and	iCal	syncing	capabilities.	On	a	somewhat	unrelated	but	still	useful	note,	you	can	also	now	sync	Google	contacts	with	your	Mac	OS	X	Address	Book.	Mac	OS	X	Leopard	only:	Today's
release	of	Mac	OS	10.5.3	added	a	juicy	little	tidbit	to	Address…Read	more	How	do	you	like	to	get	your	GCal	on	your	desktop?	Let	us	know	in	the	comments.	Adam	Pash	is	a	senior	editor	for	Lifehacker	who	isn't	happy	until	everything	syncs.	His	special	feature	Hack	Attack	appears	every	Tuesday	on	Lifehacker.	Subscribe	to	the	Hack	Attack	RSS	feed	to
get	new	installments	in	your	newsreader.
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